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Material and methods:

Reagents.

All the antibodies were purchased from Abcam (Cambridge，UK) including anti-

tubulin antibody (ab6160), anti-clathrin antibody (ab21679), anti-TOMM20 antibody 

(ab186734), goat anti-rat IgG (ab150165) and goat anti-rabbit IgG (ab150077). 

Paraformaldehyde (8%) and glutaraldehyde (8%) were bought from Hede Biotechnology 

(a distributor of Electron Microscopy Sciences, Beijing, China). Piperazine-N,N′-bis(2-

ethanesulfonic acid) sesquisodium salt (PIPES), ethylenediaminetetraacetic acid 

disodium salt dihydrate (EDTA) and magnesium chloride (MgCl2) were supplied by 

Sangon Biotech (Shanghai, China). Blocker BSA, anhydrous dimethyl sulfoxide (DMSO) 

and low-melting point agarose were obtained from Thermo Fisher Scientific (Waltham, 

MA USA). Sodium borohydride (NaBH4), Triton X-100 and methacrylic acid N-

hydroxysuccinimide ester (MA-NHS) were purchased from Sigma-Aldrich (St. Louis, 

MO USA). MA-NHS was resuspended in anhydrous DMSO at a concentration of 50 

mg/mL, aliquoted and stored at -20 ℃. Tris-HCl buffer (pH 8), phosphate-buffered saline 

(PBS), sodium chloride and acrylamide were supplied by Sangon Biotech. Sodium 

acrylate, N,N′-methylenebisacrylamide (MBAA), ammonium persulfate (APS) and 

N,N,N′,N′-tetramethylethylenediamine (TEMED) were purchased from Sigma-Aldrich. 

Proteinase K was obtained from New England Biolabs (Ipswich, MA USA). Deionized 

water was prepared by Milli-Q Ultrapure Water System (Merck KGaA Darmstadt, 

Germany).

Immunostaining of cultured cells.

HeLa cells were cultured on glass bottom dishes in RPMI 1640 medium 

supplemented with 10% fetal bovine serum (FBS) and 1% penicillin-streptomycin, and 

were maintained at 37 ℃ environment with 5% CO2. For tubulin, Cells were briefly 

washed with PBS and extracted with PEM buffer (100 mM PIPES, 1 mM EDTA and 1 

mM MgCl2 (pH 7)) containing 0.5% Triton X-100 for 30 s immediately before fixation. 
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Cells were fixed with a mixture of 3.2% formaldehyde and 0.1% glutaraldehyde 

(PFA/GA) in PEM buffer for 10 min, followed by reduction with 0.1% NaBH4 for 5 min. 

For clathrin, cells were fixed with 3.2% formaldehyde in PBS for 10 min. Then 

specimens were washed in PBS three times for 5 min each and incubated with 

blocking/permeabilization buffer (3% BSA, 0.5% Triton X-100, 1× PBS) for 30 min. 

Specimens were stained with primary antibodies at a concentration of ~10 μg/mL in 

blocking/permeabilization buffer for 2 h and then were washed three times in PBS. Then 

specimens were incubated with fluorophore-conjugated second antibodies at a 

concentration of ~20 μg/mL in blocking/permeabilization buffer for 1 h and then were 

washed three times in PBS. 

Anchoring treatment, gelation, digestion and expansion.

Gel solutions were modified from Edward S. Boyden’s recipe. Monomer solutions 

(1× PBS, 2 M NaCl, 8.625% (w/w) sodium acrylate, 2.5% (w/w) acrylamide, different 

concentrations of N,N′-methylenebisacrylamide) were prepared by mixing stock 

solutions (10× PBS, 5 M NaCl, 38% (w/w) sodium acrylate, 50% (w/w) acrylamide, 2% 

N,N′-methylenebisacrylamide). Amount of crosslinker (N,N′-methylenebisacrylamide) 

was set from 0.04% to 0.2%. Monomer solutions were frozen in aliquots at -20 ℃ and 

thawed before use. For anchoring, stained cells were incubated with 1 mg/mL MA-NHS 

overnight at room temperature, and then were washed three times with PBS. 

Concentrated stocks (10% w/w) of tetramethyethlenediamine (TEMED) accelerator and 

ammonium persulfate (APS) initiator were sequentially added to monomer solution to 

concentration of 0.2% (w/w). The mixed solution was quickly added to the well of 

confocal dish and covered with plastic wrap to isolate from air. After 1 min at 4 ℃, the 

confocal dish was placed at 37 ℃ for 3 h for gelation.

Proteinase K was diluted 1:100 to 8 units/mL in digestion buffer (50 mM Tris-HCl 

buffer (pH 8), 1 M NaCl, 1 mM EDTA, 0.5% Triton X-100). In order to improve the 

permeation of proteinase K to the embedded cells, edge of the hydrogel was cut carefully. 
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The edge-cut hydrogel was incubated with digestion solution for 4 h at 37 ℃. Then the 

digestion solution was aspirated from the confocal dish and deionized water was added. 

Water was exchanged every 2 h until the hydrogel expanded to plateaus.

Image acquisition and date analysis.

All images were acquired on A1 MP multiphoton confocal microscope (Nikon 

Tokyo, Japan). Pre-expansion image was acquired with 60× 1.4 NA oil immersed 

objective and post-expansion image was acquired with 60× 1.2 NA objective in water. If 

needed, expanded sample was fixed on confocal dish with 2% low-melting point agarose. 

For finding the same cell in pre- and post-expansion sample, we used a pre-expansion 

image captured with 10× objective as a ‘map’. We imaged the pro-expansion sample with 

10× objective and find the cells. Then we imaged the cells with 60× objective.

Estimating fluorescence retention in digestion step: To get the same size, we 

immersed samples in digestion buffer for two times before each imaging. We captured z-

series of the sample by confocal microscopy with maximal pinhole. After digestion, we 

imaged the same region with the same parameters. We calculated z-axis profile of the 

stack with ImageJ (Image → stacks → Plot Z-axis Profile) and selected the slice with 

maximal value for further measurement.1 Cell regions were selected with image 

segmentation (Image → Adjust → Threshold → Set) and mean gray values of cell 

regions were measured (Analyze → Measure) in ImageJ. Fluorescence retention was 

calculated with the measurement before and after digestion images. If needed, subtract 

the background.

Measuring expansion factor and root-mean-square (RMS) error: Expansion factors 

were determined by measuring the distance between two landmarks in both pre- and post-

expansion images with ImageJ (Analyze → Measure) and calculating the ratio of the 

measurements. Then, similarity transformation and B-spline transformation were 

performed in elastix with the method descripted by Jo. Vaughan’s group.2,3 Deformation 

vector field and RMS error were acquired with a Mathematica script written by them.3
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Measuring microtubule full width at half maximum (FWHM): Intensity profiles were 

measured over a line perpendicular to microtubule orientation by ImageJ (Analyze → 

Plot Profile). Then, the intensity data were fit to a Gaussian function with ImageJ 

(Analyze → tools → Curve Fitting → Gaussian → Fit) and FWHM was calculated from 

the Gaussian fitting.

Measuring clathrin coated pits (CCPs) radii: we divided CCP into eight equal parts 

with four straight lines through the center of CCP. Intensity profiles of the straight lines 

were obtained with ImageJ. Then, the intensity data were fit to a double Gaussian 

function in Matlab. CCPs radii were calculated from the two peaks.

Richardson–Lucy algorithm: images were deconvolved in MatLab with the code as 

below:

>> A=imread('FWHM.tif');

>> B=im2double(A);

>> PSF = fspecial('gaussian',6,3);

>> C=deconvlucy(B, PSF);

>> D=im2uint16(C);

>> imtool(uint16(D))
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Supplementary Figures

Fig. S1 Comparing expansion capacity of hydrogels with different crosslinker 

concentrations. The same size swellable hydrogels (left) expand to 6.5 times (upper right, 

with 0.06% MBAA) and 4.5 times (lower right, with 0.15% MBAA).
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Fig. S2 Expansion capacity of sample-free hydrogels with different crosslinker 

concentrations (mean ± SD, n = 3 biological replicates). For each crosslinker 

concentration, we synthesized three sample-free hydrogels, and measured the diameter of 

the gels before and after expansion. Mean value and standard deviation were calculated 

with the three hydrogels.
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Fig. S3 Illustration of expansion microscopy (this illustration is inspired by protein-

retention expansion microscopy).4
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Fig. S4 Fluorescence retention of immunostained microtubule after digestion processing. 

(A) Pre-digestion image. (B) Post-digestion image. Both scale bars are 100 µm. (C) Bar 

graph of estimated fluorescence retention caused by digestion processing for difference 

crosslinker concentrations (mean ± SD, n = 4 biological replicates). NS: not significance, 

*P<0.05, **P<0.01, Welch’s ANOVA. For each column, we immunostained four dishes 

of HeLa cells and carry out processing. We selected one region of each sample for 

fluorescence retention analysis. Mean value and standard deviation were calculated with 

the four regions.
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Fig. S5 Fluorescence retention of 0.06%-MBAA ExM and 0.15%-MBAA ExM 

(conventional ExM) before-after digestion and expansion (mean ± SD, n = 3 biological 

replicates). Two-way ANOVA shows that the differences in fluorescence retention levels 

at MBAA concentration factor were statistically significant (P <0.05), and there was no 

significant difference in fluorescence retention levels at target protein factor. For 

microtubule fluorescence retention, HeLa cells was immunostained with anti-tubulin 

antibody and Alexa Fluor 488 labeled second antibody. For TOMM20 (a mitochondrial 

membrane protein) fluorescence retention, HeLa cells was immunostained with anti-

TOMM20 antibody and Alexa Fluor 488 labeled second antibody. Cell regions were 

selected with image segmentation and integrated density of cell regions were measured in 

ImageJ. Fluorescence retention was estimated with the measurement before-after 

digestion and expansion images. For each column, we immunostained three dishes of 

HeLa cells and carry out processing. We selected one region of each sample for 

fluorescence retention analysis. Mean value and standard deviation were calculated with 

the three regions.
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Fig. S6 Fluorescence retention of immunostained microtubule before-after ExM 

processing for difference crosslinker concentrations (mean ± SD, n = 3 biological 

replicates). NS: not significance, *P<0.05, **P<0.01, Welch’s ANOVA. HeLa cells were 

immunostained with anti-tubulin antibody and Alexa Fluor 488 labeled second antibody. 

After ExM processing, samples were immersed in digestion buffer for two times and 

imaged. Corresponding cell regions were selected with polygon selection and integrated 

density of the regions were measured in ImageJ. Fluorescence retention was estimated 

with the measurement before-after ExM processing images. For each column, we 

immunostained three dishes of HeLa cells and carry out ExM processing. We selected 

one region of each sample for fluorescence retention analysis. Mean value and standard 

deviation were calculated with the three regions.
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Fig. S7 Overlay of post-expansion image before (magenta) and after (green) B-spline 

registration processing which deforms the post-expansion image to fit the pre-expansion 

image. The image was acquired with 0.06%-ExM and performed similarity 

transformation and B-spline transformation in elastix with the method descripted by Jo. 

Vaughan’s group.2,3 Deformation vector field were acquired with a Mathematica script 

written by them.3 Arrows indicate deformation vectors to align the post-expansion image 

to the pre-expansion image. Scale bar is 1 µm
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Fig. S8 RMS error analysis of ExM with different crosslinker concentrations. 

Microtubule was immunostained with anti-tubulin antibody and Alexa Fluor 488 labeled 

second antibody and used for RMS error analysis. From A to F, the MBAA concentration 

successively is 0.20%, 0.15%, 0.12%, 0.10%, 0.08% and 0.06%. Black line represents 

mean value and shaded area represents standard deviation (n = 3 biological replicates). 

For each picture, we immunostained three dishes of HeLa cells and carry out ExM 

processing. We selected one region of each sample for RMS error analysis. Mean value 

and standard deviation were calculated with the three regions.
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Fig. S9 Cross-sectional profile analysis for microtubule. Semitransparent yellow lines 

perpendicular to microtubule orientation were used for FWHM measurement. Scale bar is 

1 µm.
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Fig. S10 Microtubule FWHM analysis of ExM with different crosslinker concentrations. 

From A to F, the MBAA concentration successively is 0.20%, 0.15%, 0.12%, 0.10%, 

0.08% and 0.06%.
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Fig. S11 Bar graph of apparent microtubule FWHM measured by ExM with different 

crosslinker concentrations (mean ± SD, n = 100 microtubule profiles). **P<0.01, 

***P<0.001, Welch’s ANOVA.



S-17

Fig. S12 Clathrin-coated pits (CCPs) image obtained with 0.06%-MBAA ExM. Scale bar 

is 1 µm.
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Supplementary Table

Table S1 Problems and solutions

Problems Solutions

Cannot find a cell in post-expansion 

sample.

The cells maybe out of focal distance. If 

fix sample on confocal dish with agarose, 

don’t let the agarose solution get into the 

space between the glass bottom and the 

hydrogel.

Microtubules are not clear enough in pre-

expansion sample.

Extract cells with PEM buffer containing 

0.5% Triton X-100.

Gel solution cannot gelatinize in the well. Isolate the gel solution from air with 

plastic wrap.

Capture the same cell in pre- and post-

expansion sample.

Use a pre-expansion image acquired with 

10× objective as a ‘map’.

Post-expansion show serious distortions. Do not pressure the hydrogel, when it is 

expanding in water.

Expanded microtubules appear a lot of 

breakpoint.

Increase digestion time.
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